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Introduction

Introduction

Note: These release notes contain information that might not appear in the Help. Read them in their
entirety before you install the product. This document may also contain a number of links to external
Web sites. Micro Focus cannot be responsible for the contents of the Web site or for the contents of
any site to which it might link. Web sites by their nature can change very rapidly and although we try
to keep our links up-to-date, we cannot guarantee that they will always work as expected.

The Relativity product set enables the construction of a true relational database using existing COBOL
application data. Relativity provides a full-featured, Windows Open Services Architecture (WOSA), Open
Database Connectivity (ODBC)-compliant relational database engine. Thus, Relativity allows SQL-based
client access to COBOL application data without moving, converting, replicating, or re-engineering COBOL

data files.

With Relativity providing SQL-based access to COBOL data files, any ODBC-enabled database
development application or tool can be chosen to build applications for ad hoc reporting, decision support,
and specialized data processing functions. Relativity enables any working application to benefit from
database technology without rewriting or migrating that application.



Relativity Products

The components detailed in the Relativity Components section are available within the following products:

Designer Suite

The Relativity Designer Suite is a Windows-only development tool which enables you to create Relativity
databases. The Suite consists of the following components - the Designer, the Database Administrator, and
the Data Manager.

You can import COBOL file record definitions into the database, and then create tables based on those
record definitions.

Use the Database Administrator to maintain such things as the table connections, date constants, and
character sets used in a Relativity database.

Relativity for Windows Workstations

Relativity for Windows Workstations is Windows-only run-time product and is a single-tier solution required
when your ODBC application and COBOL data files reside on the same machine, and the ODBC
application is a 32-bit program. Relativity for Windows Workstations requires a Relativity database that was
developed using the Designer Suite.

Relativity for Windows Workstations contains the following components - Database Administrator and the
Data Manager.

Use the Database Administrator to maintain such things as the table connections, date constants, and
character sets used in a Relativity database.

Data Server

The Relativity Data Server is a run-time product which contains the Data Server for a specific platform
(Windows or UNIX), and also a platform-specific Data Client.

Itis a client/server solution required when your ODBC application is required to access COBOL data files
that reside on another machine, or when your ODBC application is a 64-bit program. The Relativity Data
Server requires a Relativity database that was developed using the Relativity Designer Suite.

This product also contains a Java Client, which is part of the client/server solution required by JDBC (Java
Database Connectivity) applications.

Relativity Products | 5
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Relativity Components

The Relativity product set consists of three main software components:

Relativity Designer

The Relativity Designer is an interactive, Windows-based tool that enables the COBOL application
developer to define and maintain a relational database system of tables using COBOL data.

The Relativity Designer creates the Relativity catalog by performing the following functions:

» Automatically extracts the definitions of data files from the COBOL programs into the Relativity catalog.
* Collects information regarding the data from the application developer.

« Allows the developer to define relational tables from existing COBOL data items within records of
existing COBOL files.

If an owner group has been assigned to the catalog, only users who are members of that owner group may
open the data source associated with the catalog using the Relativity Designer. Assignment of an owner
thus protects the sensitive data in the catalog exposed by the Relativity Designer from access by users
who are not owners. A password-protected log on procedure validates user identities whenever a Relativity
data source is opened, as explained in Providing Data Security.

Relativity DBA

The Relativity DBA (Database Administrator) is an interactive, Windows-based tool that enables the system
administrator at the end-user location to maintain and manage the Relativity database and the security of
the Relativity database.

The Relativity DBA provides the following functions:

» Defining and authorizing users of the database.

» Restricting the view of the data for individual groups of users.

* Maintaining the linkages between tables and physical COBOL data files.
« Defining date constants.

* Merging security and connection information into a new catalog (an optional function controlled by the
catalog developer).

* Producing reports on security and connections.

The Relativity DBA can be used only by users who have the Use Administrator privilege set for the
catalog, or by the catalog owner (who has all privileges set by default). The owner may grant this privilege
to one or more administrative groups - see Defining Group Privileges.

Relativity Database Management System

The Relativity Database Management System (DBMS) connects Windows client-based tool products to
COBOL data files. It processes SQL requests from the ODBC-enabled application (or tool) and performs
the necessary actions to respond to the request with data obtained from the COBOL data files.

The Relativity DBMS comes in two variants: single-tier and a client/server. The single-tier product is named
the Relativity Data Manager. The client/server product is named the Relativity Data Client and Relativity
Data Server.

Relativity Components



Relativity Data Manager

The Relativity Data Manager is a single-tier version of the Relativity DBMS. By single-tier, we mean that the
product is installed on a single machine. In this configuration, the COBOL data files are installed on the
same machine as the ODBC-enabled application and the Relativity Data Manager.

Relativity Data Client and Relativity Data Server

The Relativity Data Client and Relativity Data Server are a client/server version of the Relativity DBMS. In
this configuration, the COBOL data files are typically not on the same machine as the ODBC-enabled
application. In this case, the Relativity Data Client is installed on the same machine as the ODBC-enabled
application, and the Relativity Data Server is installed on the same machine as the COBOL data files. The
Data Server needs to be installed only once and on only the server machine, that is, the machine with the
COBOL data files. The Data Client needs to be installed on each client machine that needs access to the
data on the server machine. The Data Client sends the SQL requests from the ODBC-enabled application
to the Data Server, which then processes the requests and returns only the resulting rows to the Data
Client, which in turn returns them to the ODBC-enabled application.

Relativity Components | 7



What's New

8 | What's New

This section details the new features added in each release of the Relativity products:

New features in Relativity 2.4
The following features are new to this release of Relativity:

e Catalog options
« Catalog report

Catalog options
Back to the list

Catalog options can be overridden with the options set per file definition.

Catalog report
Back to the list

The Relativity Designer provides a set of predefined reports to give a comprehensive overview of a catalog.

New features in Relativity 2.3
The following features are new to this release of Relativity:

» New Designer user interface

e 64-bit Data Server on SUSE

e SQL_C _ SBIGINT and SQL_C_UBIGINT support

« Foreign key support

« New documentation: Relativity Data Server Utilities on UNIX

New Designer user interface
Back to the list

The Relativity Designer has been redesigned with modern user interfaces. The original Designer has been
renamed to the Classic Designer and will also be installed in this release, and you can continue to use it;
however, we encourage you to transition to the new interface, as the Classic Designer is expected to be
removed in a subsequent release.

64-bit Data Server support for SUSE
Back to the list

The Relativity Data Server for SUSE has been updated to run as a 64-bit process on SUSE 12. The
RUNACTIVE script will determine if a 32-bit or 64-bit COBOL (either Visual COBOL or Server Express) is
in use and launch the appropriate Data Server.

SQL_C_SBIGINT and SQL_C_UBIGINT support
Back to the list

The ODBC 3 Relativity Data Manager and Data Client (but not the Relativity Data Manager for ADO, nor
the Relativity Data Client for ADO) now support 64-bit C integers SQL_C_SBIGINT and SQL_C_UBIGINT.



Note: This does not include support for 64-bit (BIGINT) columns; however, DECIMAL(20,0) columns
will contain a SQL_C_SBIGINT.

Foreign key support
Back to the list

Relativity has been enhanced to support the ODBC API call SQLFor ei gnKeys. The new Designer has the
ability to designate a connection between columns in two different tables, creating foreign keys. These are
columns that you usually use in joins. Adding this information allows SQL tools to optimize queries that
they generate, and to present the foreign key association graphically.

Note: It is up to the SQL tool to make use of this information; Relativity does not directly use it, nor
validate it. It is up to the database designer to make valid associations.

New documentation: Relativity Data Server Utilities on UNIX
Back to the list

New documentation is now available for the RelServerAdmin, RelClientAdmin, RelClientTest, and
RelDriverAdmin utilities on UNIX. This document, entitled Relativity Data Server Utilities for UNIX, is
available from the product's Support page: www.microfocus.com/documentation/relativity/

New features in Relativity 2.2

There are no new features included in this release of Relativity.

New features in Relativity 2.1 HotFix 1

There are no new features included in this HotFix.

New features in Relativity 2.1
The following features are new to this release of Relativity:

¢ Net Express and Server Express support
* COBOL syntax files
- ODBC driver for ADO

Support for Net Express and Server Express
You can now install and Relativity with either Micro Focus Net Express or Server Express.

See Software Requirements in these Release Notes for information about which versions of Net Express
and Server Express are supported.

COBOL syntax files

The COBOL FD Importer within Relativity Designer invokes the COBOL compiler to generate information
about a COBOL program’s File Definition and saves it to COBOL syntax file. The wizard then reads the
information from that file and imports it into the Relativity catalog.

The COBOL syntax files have a different extension based on which Micro Focus product you have installed
Relativity for:

» . CST, if you use Relativity with either Visual COBOL or Enterprise Developer
e . RST, if you use Relativity with either Net Express or Server Express

A new ODBC driver

This release provides a new Relativity ODBC driver which is optimized for ADO support.

What's New | 9


https://www.microfocus.com/documentation/relativity/

When you use Relativity with an ADO application, it is strongly recommended to use the ADO version of
Relativity. To do this:

1. Open the ODBC Administrator and click Add.

This displays a list of all ODBC drivers installed on your machine.
2. Select a driver that is appropriate for your environment:

* Micro Focus Relativity Data Manager for ADO (32-bit)
« Micro Focus Relativity Data Client for ADO (32-bit)
« Micro Focus Relativity Data Client for ADO (64-bit)

10 | What's New



Resolved Issues

Resolved issues in Relativity 2.4

The numbers that follow each issue are the Support Incident Numbers followed by the defect number (in
parentheses).

* [nstallation

» Designer
« Data Manager
« Data Client

 Data Server

Installation
Back to the list

« Configured Linux installations with systemd available to set up managed server. Default is now to install
systemd or initd managed Relativity Data Server.

(390038)

« The Relativity Data Client (32/64-bit) installation now creates a shortcut to the Relativity Server
Administrator (32/64-bit) program. The Relativity Data Manager and Relativity Data Server installations
now create a shortcuts to the 32-bit Relativity Administrator program.

(389039)

* Anissue with installing Java Client on Ubuntu systems has been fixed.
(88033)

« Instructions for installing a 64-bit Data Client on UNIX have been added to the Data Server release
notes.

00370453 (11460)

Designer
Back to the list

* Anissue with display of warnings/errors in File Definition Editor pane has been fixed.

(364114)
» Previously, there was an issue with assigning YYYYMMDD transform to numeric data type. This does
not exist in Relativity 2.4.

02423276 (364162)
« Anissue concerning the sorting of non-string columns in a data table has been resolved.

(5956)
« An issue with spaces in character set path name has been resolved.

(6981)
« Anissue concerning Character Set drop down list box not being updated has been resolved.

(8102)
* Anissue concerning re-opening a DSN after importing from a COB file has been resolved.

(8321)
e An administration issue regarding the creation of new DSNs has been resolved.

Resolved Issues
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(8581)

« Options have been added for creating columns from FILLER data items or from data items with
OCCURS.

(8830)
« Anissue where data was being cut off when a query had a criteria has been resolved.

(9016)
« Anissue regarding error messages on failed login attempts has been resolved.

(10234)
< Anissue concerning the re-opening of unreadable RST files has been resolved.

(10540)
e Anissue with the CST FD importer to use user-supplied copybook path has been fixed.

00370967 (12455)
* Anissue with COBOL FD import failing with "Object reference" error has been fixed.

00370967 (12456)
* There is no longer an issue with setting transforms on COMP data items.

00367792 (12515)
e Itis now possible to configure some data source options at the file level in Relativity Designer.

00372878 (13082)
« An issue with adding conditions (88s) to function data items has been fixed.

00367792 (13358)
« An issue concerning "The value violates the MaxLength" exception has been resolved.

00371598 (13409)
« Anissue concerning creating a table after skipped merge errors has been resolved.

00371598 (13421)
« Anissue with modifying user/group passwords in Relativity Designer has been fixed.

00370967 (13424)
* Anissue with report writer in Relativity Designer and Database Administrator has been resolved.

00366691 (13550)
< Anissue concerning custom character sets not appearing in FD's property pane has been fixed.

(69239)

« Anissue concerning updating FD character set property has been resolved.
(71232)

« Anissue concerning Value is null error when importing COB files has been resolved.
(71233)

« Anissue where data fetching with query builder failed has been resolved.
(74012)

« Anissue concerning the message "Unexpected report PrivilegesByGrantee" has been resolved.
(74013)

« Reports save dialog now starts in the reports directory set in the user options.
(75004)

e Anissue concerning DBA crash while creating a System data source has been resolved.
(75008)

< Anissue concerning the double-clicking of File Definition in the Character Set editor has been resolved.
(76007)

12 | Resolved Issues



An issue concerning error messages from a failed character set compilation has been resolved.

(77020)

An issue concerning the Source/Copy Path setting during an FD import has been resolved.
(82048)

An issue concerning NumberFormatException has been resolved.

(91048)

An issue involving opening importer without first establishing a connection has been resolved.
(92067)

An issue concerning bad index on merged record variants has been resolved.

(92073)

Export DDL is now available via context menu on tables in the Explorer pane.

(123087)

Relativity Designer now tolerates some kinds of bad data in the catalog.

01943647 (146097)
An issue with updating an FD with a file label has been resolved.

02015997 (156117)
Remote import from Visual COBOL Development Hub has been fixed.

(157040)
An issue concerning merge tables with multiple instances has been resolved.

01964909 (157119)
An issue concerning the writability of relative files with keys has been fixed.

01991289 (163031)
An issue concerning adding subscripts in record types to a table has been resolved.

02052536 (182062)
FD importer no longer halts if the compiler has warnings.

02152832 (204044)
An issue concerning merge flattened tables has been resolved.

02211450 (246030)
An issue involving duplicated record size items has been resolved.

(260210)
An issue concerning add FILLER as a column to a table has been resolved.

(285072)
An issue concerning importing from Visual COBOL 8.0 has been resolved.

(303049)
"View data" operations have better error and warning messaging.

02423280 (365189) 02080260 (182069)
An issue concerning flattening multi-dimensional arrays has been fixed.

02427159 (372012)
An issue with merging flattened occurs has been resolved.

(382021)

JDBC 2.1 documentation and samples are no longer installed with the Relativity product. JDBC 4.3 is

still included.
(390043)

Resolved Issues
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The Relativity Designer can now configure data source options at the FD level, as opposed to the entire
data source.

(385022)

There was a problem in the Relativity Designer in which Designer could get into an infinite loop when
disconnecting from the data source when performing a merge from a catalog using a Client/Server data
source. This has been fixed.

(92072)

The Relativity Designer and DBA are now aware of the size/scale of each monitor and will rescale
themselves to a constant size when the monitor DPI changes, or when moved between monitors with
different DPI or scale settings. Note that only the Designer and DBA support this functionality; dialogs
and message boxes from the Relativity drivers will not be resized.

01990144 (156050)

Importing an RM/COBOL COB file that has an extension other than .COB no longer causes an
exception.

01970795 (156052)
In the Designer preview pane, Dates are now shown in short date format.

(442061)
Import compilation message are now scrollable.

(429079)
Global editing of paths for table connections has been implemented.

(136020)
In the Designer preview pane, dates are now shown in short date format.

(442061)

Data Manager
Back to the list

Resolved Issues

Support for Unsigned Integer Columns added to Data Manager. Previously, a column defined on an
unsigned binary data item (unsigned COMP-4 or BINARY) would be treated as a signed integer column
by the Data Manager and an unsigned integer column by the Data Server and Data Client. The Data
Manager was corrected, but because there might be applications that were relying on this behavior, a
configuration option was also added to enable that behavior again.

(389043)

The Relativity Data Manager was changed to return the error -4184, "Data source's code page is not
supported”, when a Windows machine is running with an unfamiliar code page, such as UTF-8, and the
data source was created to use the default Code Page.

(9668)

Prior to Relativity 12.19, there was an unknown difference in behavior between the Relativity Data
Manager and Data Client. A column defined on an unsigned binary data item (unsigned COMP-4 or
BINARY) would be treated as a signed integer column by the Data Manager and an unsigned integer
column by the Data Server and Data Client. Thus, a column defined on PIC 9(9) COMP-4 data items
that contained the value H"FFFFFFFF", would be stored as 4294967295 by the Data Client and a -1 by
the Data Manager. It was determined that the Data Manager was behaving incorrectly, as the picture
clause clearly described the data item as unsigned. The Data Manager was corrected in 12.19, but
because there might be applications that were relying on this behavior, a configuration option was also
added in 12.19 enable that behavior again. See the Relativity Administrator's help file for more
information. See the Enable Unsigned Integer Columns option on the Setup Options Page (Global tab)
in the Relativity Admin Help file for more information.

(150075)



Data Client

Back to the list

A cast issue with signed int being treated as unsigned has been fixed.

(8219)
DataClientConfig.sh script on UNIX will now check for a valid ODBC data manager using reldriveradmin
before continuing with the configuration.

(389042)
An issue with retrieving Long VarChar data has now been resolved.

(11707)
An issue with SQL warnings being lost has been resolved.

00367793 (11707)
A problem with the 64-bit UNIX Data Client on AlX, in which the reldriveradmin64 utility would
experience a memory fault and stop executing has been fixed.

(10078)
A problem in the Relativity server administrator where garbage characters can appear at the end of the
application name in the server status display has been fixed.

(8450)
Previously, the insert of dates failed for 64-bit Relativity ADO client and worked with 32-bit. This has
been fixed.

00373472 (12652)
A memory leak in the Data Client code where descriptors declared for the SQL Exec Statement were
not being freed has been fixed.

(92070)

There was an issue on UNIX wherer el cl i entt est could not load the ODBC driver manager. Now
rel clienttest has been configured to load the ODBC driver dynamically instead of dynamically
linking to a specific product version. The change requires that the library path is set on the machine in
order to find the library.

(415072)

The Relativity 64-bit Data Client administration programs no longer experience segmentation faults on
AlX.

(435011)

The user can now continue adding DSN's beyond the previous limit which was restricted by a max
buffer size. The system will now continue to expand the buffer as needed. However, If the system has a
large number of DSNs defined, the request to list data sources will be truncated if the buffer limit of
5196 is reached.

(9139)

Data Server

Back to the list

A memory leak has been corrected in the Relativity Server Admin command line program.

(9338)

There was a problem where, if a database contains table with a decimal column with a precision that
was larger than 9 digits and smaller than 19, and this table and column was accessed using the
Relativity for ADO data client, the error "Error in assignment” was returned. This has been fixed.

3239325 (11739)
A problem with the Relativity Data Server Help button has been fixed.
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(75003)
« The Relativity Data Server will now properly open a relative file.

02441194 (380040)
* Anissue with compiling in Data Server using Ubuntu has been fixed.

(80030)

« The 64-bit Data Server no longer incorrectly reports errors as General Errors. The proper errors are
reported.

(415133)

Resolved issues in Relativity 2.3

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

* |nstallation

« Designer

« Data Manager
« Data Client
Installation

Back to the list

« Data Server installation now correctly configures COBOL Server 2013.

(610408)

« Data Client now uninstalls cleanly.
(641421)

» Relativity now uninstalls cleanly when multiple components exists.
(641462)

- DBA and Designer installations now create the correct registry keys.
(641737)

Designer

Back to the list

« ODBC Control Panel now displaying correctly on the Tools menu.
(629654)
e The 64-bit ODBC Administrator menu option now available on 64-bit systems.

(629655)

« If required, you are now prompted to elevate the privileges in order to run Server Administrator from the
Tools menu.

(629656)
« A shortcut to the Relativity Designer Samples directory is now included, to make them easier to locate.

(629710)
* The Designer no longer hangs when attempting to access the DBMS help file from the Help menu.

(629733)
» If required, you are now prompted to elevate the privileges in order to run the 64-bit ODBC
Administrator from the Tools menu.

(630446)
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Related links in the help topic 'Augmenting the COBOL File Definition in the FD Form' have been fixed.

(631007)

Condition item matching now working correctly.

(635635)

COBOL syntax file now generated correctly during import.

(641412)

The Help file for the classic DBA product now displays correctly.
(641424)

The import process when using a remote CST file now works correctly.
(641428)

The Help file for the DBMS product now displays correctly.

(641468)

Signed numeric edited data items are now handled correctly during import.
(1106585)

Use MAXCOLSUPPORT to override the 256(254 user defined) column limit in the Relativity Database.
It's a registry value on Windows, and an CDBC. i ni value on UNIX.

(1114252)
Error message relating to Working Storage item updated to be more helpful.

(1114406)
The CST import process now correctly translates numeric value strings into the appropriate catalog
data types.

(1114501)

DateTime formats used in a loaded catalog are dynamically turned on so that they are not hidden from
the user.

(1118541)
Field offsets now shown in the correct order.

(1118543)

Data Manager
Back to the list

Excel 2013 64-bit no longer crashes when trying to connect to a Relativity data source.

(631186)

Data Client no longer crashes when opened under the Designer whilst running/debugging under Visual
Studio.

(641531)

Data Client

Back to the list

A heavily-loaded Relativity Data Server no longer crashes intermittently on Linux.
(1114873)

Resolved issues in Relativity 2.2

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
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» Designer
» Data Manager
» Data Client

Designer
Back to the list

* A problem with launching the Relativity Server Administrator from the Designer and DBA Tools menu
has been corrected. A problem with locating the Server Administrator help file has also been corrected.

(1105713)

Data Manager
Back to the list

« Relativity now works properly with Microsoft Word when used as a source for a Microsoft Word mailing
list.

(628929)

Data Client
Back to the list

« The 64-bit Relativity Server Administrator no longer crashes on Windows 10 when it attempts to create
a catalog.

(629199)

Resolved issues in Relativity 2.1 HotFix 1

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

« Data Manager
» Designer

Data Manager
Back to the list

e An INSERT into a table defined on a sequential file no longer fails with COBOL error 48,1 when using
the Relativity for ADO driver.

2873824 (1106557)

Designer
Back to the list

< A problem in the Relativity Designer that caused an error to be reported when importing tables from
another catalog is fixed. The error occurred if an imported FD had multiple unnamed FILLER items. The
first item was correctly merged, but errors were reported on subsequent FILLER items in the same FD.

2874985 (1106659)

Resolved issues in Relativity 2.1

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
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« Data Manager
« Data Server

Data Manager
Back to the list

« Anissue where data files with edited data items, such as PIC -9(6).9(2), would return 0 in columns
associated with such data items, if the data item contained EBCDIC characters has been fixed.

2862434 (1105012)
* An INSERT into a table defined on a sequential file no longer fails with COBOL error 48,1.

2849810 (1103083)

Data Server
Back to the list

« The Data Server no longer writes "Assert” messages to the server.log file.
(616728)

Other resolved issues:

. 2862434 (1105011)
. 2859204 (1104837)
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Installation

System requirements

Installation

Hardware requirements

The requirements for this Relativity product are in addition to the requirements of the Micro Focus product
you have installed - either Visual COBOL, Enterprise Developer, Net Express or Server Express. See the
in-product documentation for details of the respective product's requirements.

The disk space requirements are, approximately:

Platform Relativity Designer Suite License Administration tool
x86 Windows platforms 100MB 25MB

x64 Windows platforms 100MB 25MB

UNIX 100MB 100MB

Operating systems supported

This product operates on the following operating systems/platforms:
With Visual COBOL and Net Express:
e Windows 7, 10, and 11; Server 2012/R2, 2016, and 2019.

Software requirements

This Relativity product requires one of the following Micro Focus COBOL development or deployment
products.

* Visual COBOL or Enterprise Developer (including Development Hub and UNIX Components variants),
version 5.0 or later.

« Enterprise Test Server, version 5.0 or later.

¢ Net Express 5.1 Update 18.

e COBOL Server or Enterprise Server, version 5.0 or later.

e Micro Focus Server 5.1 Update 18.

Other requirements

This product requires the latest version of the Micro Focus licensing software that is installed with Visual
COBOL version 9.0 or later. If you have one of the products listed above installed locally, you will already
have a license manager installed. If the product is version 8.0 or older, the license manager must be
updated to the most recent version in order to install a Relativity license.

For Windows, updated license manager installers are included in the Relativity distribution. If you are using
a version of Visual COBOL or Net Express earlier than 9.0, please install the license manager included
with Relativity by running | nset upx64. nmsi on Windows 64-bit, or | mset upx86. msi on Windows 32-bit.
If the installed license manager is a more recent version than the license manager included with Relativity,
it will not be updated or replaced. If the installed license manager is older, it will be updated but existing
licenses that are already installed will not be affected.




Additional software requirements

To ensure full functionality for some Visual COBOL or Enterprise Developer features, you might be required
to obtain and install third-party software in addition to the prerequisite software installed automatically by
the product setup file.

Compiling Java

Refer to the Additional Software Requirements in the product documentation supplied with the COBOL
product being used; this will stipulate the minimum required version of Java Development Kit (JDK)
required to compile Java, if required, during the import and update processes.

JDBC Support

Refer to the Software Requirements in the product documentation supplied with the COBOL product being
used; this will stipulate the minimum required version of Java Platform, Enterprise Edition (Java EE)
required to execute the Java Client and develop a JDBC application.

Downloading the product

Use the download links in your Electronic Product Delivery email to download the required Relativity
products.

For more information, follow the same links for the installation instructions and the End User License
Agreement.

Restrictions and requirements

Before starting the installation on Windows, you should consider the following:

» If, when you install a Relativity product, the machine does not have the correct version of the Microsoft
Visual C++ Redistributable Run-time already installed, it is installed as part of the Visual COBOL,
Enterprise Developer, or Net Express install. This installation adds a number of . dl | files, without
digital signatures, into the wi nsxs directory.

« Your account must have administrative permissions to install this product. If your account does not have
these permissions and cannot obtain them, you will be asked to provide the credentials of an
administrator during the installation.

Installing Relativity Designer Suite

i Note: Before installing, see Restrictions and Requirements.

This version of the product is a full install.

What to install

You need to install the following files, in the following order:

« The license manager install file, either | mset upx64. nsi or | nset upx86. nsi . If an older license
manager is currently installed, it will be upgraded and you will not have to reinstall existing license files.
The installation will not alter a more recent license manager.

« The Data Manager install file - Dat aManager x86. nsi . See Data Manager installation.
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Installation

Note: If you plan to use the Data Server product for communications, you do not need to install the
Data Manager. Instead, you must install a 32-bit Relativity Data Client in order to communicate
with the Data Server. See the Release Notes of Relativity Data Server for more information.

« The Designer install file - Desi gner x86. nsi . See Designer installation.

* The Database Administrator install file - DBAx86. nsi . See Database Administrator installation.

Note: This install is optional. Only install the Database Administrator if you require ongoing
maintenance of Relativity databases.

Data Manager installation
y Note: The Data Manager is only available on Windows.

The Data Manager is one of the core pieces of the Relativity product. Either the Data Manager or a Data
Server/Data Client must be installed in order to use the other Relativity products. The Data Manager is
required in situations where the data files are located on the same Windows machine as the ODBC
application, and the ODBC application is a 32-bit program. If either of these conditions is false, you will
require the Data Server product instead.

The Data Manager requires an installation of other Micro Focus products in order to access data files. If the
Data Manager is to be used with the Relativity Designer Suite in order to develop Relativity catalogs, Visual
COBOL, Enterprise Developer, Net Express or Server Express must be installed on the same machine as
the Data Manager. If the Data Manager is not to be used to develop catalogs, in other words it is being
installed in a production environment, you only require an installation of COBOL Server, Enterprise Server
or Micro Focus Server.

To install the Relativity Data Manager:

1. Run Dat aManager x86. nsi and follow the wizard instructions to install the prerequisite software and
the product.

2. Following installation of the Data Manager, install a license using the Micro Focus License
Administration; see Installing licenses in these Release Notes for more information.

Note: You must also license the Micro Focus product you have installed Relativity for (either Visual
COBOL, Enterprise Developer, Net Express, Server Express, Enterprise Server, COBOL Server,
or Micro Focus Server) with its own license.

3. Following installation of a license, use the 32-bit ODBC Administrator to create a data source. The
ODBC application will use the data source name to establish a connection to the Relativity Data
Manager and a Relativity catalog, which contains information about a Relativity database. See Data
Manager Verification for more information.

Designer installation
f Note: The Designer is only available on Windows.

The Relativity Designer is a program intended to develop and maintain Relativity databases. The Designer
does not need direct access to the catalog file for the Relativity database. It performs its work through an
existing data source, either through Data Manager or Data Client.

One of the Designer's functions is to import the definitions of file record layouts into the Relativity database.
To do this, it requires access to a COBOL development system where it must be one of the following
products - Visual COBOL, Enterprise Developer, Net Express or Server Express. The COBOL
development system does not need to be installed on the same machine as the Designer; it can also use a
development system that is installed on the same machine as a Relativity Data Server for UNIX. If your
Relativity Data Server is for Windows, use the Visual COBOL IDE to produce a CST file locally and import
the File Descriptions from that into the Relativity catalog.



The Designer is a 32-bit ODBC application, and will require a data source created by the Data Manager or
the 32-bit Data Client that links to the Relativity database you want to maintain.

To install the Relativity Designer:

1. Run Desi gner x86. nsi and follow the wizard instructions to install the prerequisite software and the
product.

2. Following installation of the Designer, you need to create a 32-bit data source, as detailed in Data
Manager verification. If you are creating a data source for an existing Relativity database, all that is
necessary is to create the required data sources and associate them with the database catalog file. If
you are developing a new database, you must create a new catalog file at the same time that you create
the data source; this catalog file must be located on the same machine as the data files, and for the
sake of simplicity, in the same directory as the data files.

3. See Importing COBOL File Definitions into Relativity in the Relativity Designer Help for details on how
to import the file definitions into a Relativity database, and then to create tables on those file definitions.

Database Administrator installation

f Note: The Database Administrator is only available on Windows.

The Database Administrator (DBA) is a program intended to maintain a Relativity database after
development. It does not require Visual COBOL or Enterprise Developer to be installed on the same
machine.

The DBA is a 32-bit ODBC application used to maintain such things as the table connections, date
constants, and character sets used in a Relativity database. It will require a 32-bit Data Manager or 32-bit
Data Client data source to a Relativity database in order to maintain it.

To install the Relativity DBA:

1. Run DBAXx86. nsi and follow the wizard instructions to install the prerequisite software and the product.

2. Following the installation of the DBA, create a 32-bit data source, using either the Data Manager or 32-
bit Data Client, in order to access and maintain the database; see Data Manager verification for more
information.

3. See the Relativity DBA Help for details on how to maintain a Relativity database.

License Manager Installation
i Note: The following information applies to Windows only.

The Micro Focus License Manager may have already been installed by another Micro Focus product. While
Relativity works with older versions of Micro Focus COBOL products, it requires the license manager
installed by Visual COBOL version 9.0 or later.

The License Manager is included with the Relativity distribution and is backward-compatible with previous
license managers. The installer will upgrade an older license manager and preserve previously installed
licenses, but will not downgrade more recent license managers. This means that it is safe to install, even if
you don't know the version of the license manager that was previously installed.

To install the license manager:

1. Run either | nset upx64. nsi on 64-bit Windows, or | nset upx86. nsi on 32-bit Windows.

2. Follow the prompts. Be sure to install both the SafeNet Sentinel and AutoPass options, which are
selected by default.

Installation
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Installation verification

By verifying the installation of each product in the Relativity Designer Suite, you also undertake the initial

Installation

setup.

The following instructions assume that you have run all required product installations for Relativity Designer
Suite. It is useful to have an ODBC-enabled application, such as Microsoft Access, also installed to fully

verify the installation.

Data Manager verification

After Data Manager is installed, you need to create a data source name to establish a connection to the
Data Manager and the Relativity catalog.

1. Open the 32-bit ODBC Administrator (see Locating the ODBC Administrator).

The ODBC Data Source Administrator window appears.

2. Click Add.

The Create New Data Source window appears.
3. Scroll down through the list of installed ODBC drivers and select Micro Focus Relativity Data
Manager (32-bit), and then click Finish.

The Relativity window appears.
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4. In the Data Source Name field, enter Verify.

5. Click Select Catalog.

The Select Catalog for Data Source window appears.
6. Navigate to %°UBLI C% Docunent s\M cro Focus\ Rel ativity Data Manager\ Sanpl es\ M-

\Verify.

7. Selectveri fy. rcg, and then click Open.

The Relativity window appears.



8. Click OK twice to close the Relativity and ODBC Data Source Administrator windows.

At this point, the Relativity driver has been loaded, it has opened a Relativity catalog, and a Relativity
database has been created. This has thoroughly exercised the installation; however, as an extra step, start
a 32-bit ODBC application, open the Verify datasource, and then execute the following SQL query:

SELECT * FROM BACKORDER
The result should show the BACKORDER table that started life as a COBOL data file.

Designer verification

Note: This verification assumes that you have completed the Data Manager or Data Client
verification, and have created the data source named Verify.

1. Start the Relativity Designer.
The Relativity Designer window opens.

Note: When you start Relativity Designer, you are prompted to open the last opened data source.
If the Database Logon dialog box is displayed, click Cancel.
2. On the File menu, select Connect to Existing Data Source.

The Open Existing Data Source dialog box is displayed. (If you selected Connect to <data source
last opened>, skip the next step.)
3. On the Open Existing Data Source dialog box, select the Verify data source, and then click Connect.

As the catalog associated with this data source has no security (that is, no group owner) configured yet,
the catalog is opened immediately.
4. In the Catalog Explorer, double-click the Table Definitions node.

The BackOrder table definition is displayed.
5. Double-click the Backorder table definition.

Just above the table form, click (Preview Table Data).

A preview of the table is displayed, showing how it would look in an ODBC-enabled application.

Locating the ODBC Administrator

The Windows ODBC Administrator is an important utility due to its role of creating data sources. You must
open the correct version of the ODBC Administrator appropriate to the bitism of data source that you
require.

Windows 7

On a 32-bit Windows machine:

1. From the Start menu, open the Control Panel.
2. Do one of the following:

» If the Control Panel is displaying in Category view, select System and Security, and then
Administrative Tools.
« If the Control Panel is displaying in Icons view, select Administrative Tools.
3. Double-click Data Sources (ODBC).

The ODBC Data Source Administrator screen appears.
On a 64-bit Windows machine:

Creating a 32-bit data source for the Relativity Data Manager or the Relativity 32-bit Data Client requires a
32-bit ODBC administrator on 64-bit Windows. Unfortunately, that is not the default ODBC administrator on
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a 64-bit Windows 7 machine. To start the required ODBC Administrator, follow one of the procedures
below:

* To open the 32-bit ODBC Administrator:

1. From the Start menu, in the Search programs and files box, type odbc.
2. In the results box, double-click ODBC Data Source Administrator (32-bit).

The ODBC Data Source Administrator screen appears.

, Tip: To speed up access to this utility, right-click ODBC Data Source Administrator (32-bit)
and select Pin to Taskbar or Pin to Start Menu.
* To open the 64-bit ODBC Administrator:

i

1. From the Start menu, open the Control Panel.
2. Do one of the following:

« If the Control Panel is displaying in Category view, select System and Security, and then
Administrative Tools.
« If the Control Panel is displaying in Icons view, select Administrative Tools.
3. Double-click Data Sources (ODBC).

The ODBC Data Source Administrator screen appears.

Windows 10 and later

You start the desired ODBC Administrator from the Start menu - locate the Administrative Tools group
(from the Start menu, you can start to type the group name and the option should appear), and then select
ODBC Data Sources (32-bit) or ODBC Data Sources (64-bit), depending on the type of data source to
maintain.

Post-installation considerations

The steps you must perform after installation depend upon the location of the data files, if you are
developing a Relativity catalog, and if you have an existing Relativity catalog or not.

Location of data files

« If the data files exist on a Windows machine, and the 32-bit ODBC application is installed on the same
machine, you only need to create a data source using the Windows ODBC administrator.

« If the data files exist on a Windows machine, and the 64-bit ODBC application is installed on the same
machine, you must create a server data source using the Data Server for Windows, and then create a
client data source using the 64-bit Data Client that references the server data source. (There is not a
64-bit Data Manager.)

« If the data files exist on a Windows machine that is separate from the ODBC application, you must
create a server data source on the Windows machine containing the data files, install the Data Client on
each client machines containing the ODBC application, and then create a client data source on each
that references the server data source.

« |If the data files exist on a UNIX machine, you must create a server data source on the UNIX machine
containing the data files, install the Data Client on each machine containing the ODBC application, and
then create a client data source on each that references the server data source. (There is not a single-
tier Data Manager for UNIX.)
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Developing a new Relativity catalog

If you are developing a new Relativity catalog, you must install the Designer, and, if you do not have an
existing catalog, create a new data source that references an empty catalog. Follow the directions in
Location of Data Files for the type of data sources to create based upon the location of the data files.

In the case of development, the ODBC application is the Designer, and it must reside on a Windows
machine, but note that it uses a data source to locate the Relativity catalog; thus, you will be able to
develop with data files that are located on a remote server machine.

To develop a new Relativity catalog, see the Relativity Designer's help file for How-To information on
developing the catalog.

Developing an existing Relativity catalog

If you are upgrading Relativity, and have an existing Relativity catalog, you only need to create a data
source that references the existing catalog.

If you are installing this catalog at an end-user site, do not install the Designer; although you might want to
install the Relativity DBA on an administrator's machine to allow maintenance of user IDs and catalogs.
See the Relativity DBA's help file for How-To information on maintaining the catalog at an end-user site.

Uninstalling

Windows - all components
To uninstall one or more Relativity products from Windows:

1. Log in with the same user ID you used when you installed the product.
2. From the Start menu, open the Control Panel.
3. Do one of the following:

» If the Control Panel is displaying in Category view, click Uninstall a program under Programs.
» If the Control Panel is displaying in Icons view, double-click Programs and Features.
4. Select one of the following products and click Remove or Uninstall:

e Micro Focus Relativity Data Manager
e Micro Focus Relativity DBA
* Micro Focus Relativity Designer
5. Click Yes to confirm.
6. If required, repeat from step 4 to uninstall further products.

This process only removes files that the installation software installed. If the product directory has not been
removed, delete any unwanted files and sub-directories within it using Windows Explorer. The following
folders might not be removed:

* The Micro Focus product name folder in the Start menu - you can delete this manually.

 Usystenmdrive% User s\ Publ i c\ Docunent s\ M cro Focus - this includes the binaries and the log
files of the samples you have built.

e orogranbDat a% M cro Focus - this includes some data files used by the Micro Focus licensing tool.

« 9% rogram Fil es®4 M cro Focus - you can delete this manually.

Some registry entries are also not removed by the uninstallation process and you need to manually delete
them.
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To uninstall a product from the command line, you need the installation file, and you need to execute the
following command:

nsiexec /x install-file.nsi
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Licensing information

To use Relativity, you need to purchase and install a license for it. To buy a license, contact your sales
representative or Micro Focus Customer Care.

In addition, the Micro Focus product you have installed Relativity for (either Visual COBOL, Enterprise
Developer, Net Express, Server Express, Enterprise Server, COBOL Server, or Micro Focus Server) must
also be licensed with its own license.

i Note:

» If you have purchased a license for a previous release of Relativity, that license will also enable
you to use this release.

» Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus Customer
Care.

Relativity uses the Micro Focus License Administration software for installing and managing your Micro
Focus licenses. See the instructions in the following sections about how to install the Relativity license.

To start Micro Focus License Administration

To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:
C \Program Files (x86)\M cro Focus\Li censi ng
2. Type cesadni nt ool . bat , and press Enter.

Installing licenses

You need either a license file (with a . nf | i ¢ extension for Sentinel RMS licenses or an . xim extension for
AutoPass licenses) or an authorisation code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only).

If you have a license file

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
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» Click Browse next to the License file field and select the license file (which has an extension
of . xnl).

» Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
2. Enter the name and location of the license file.

If you have an authorization code

i Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection

f Note:

» This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

e Itis not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.

2. Click the Install tab.

3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection

Note: This topic only applies if you have an authorization code. Authorization codes are only available

with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Licensing information



To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.

On the Install tab, click Manual Authorization.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

WD

» If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

< If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.

5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

Type the Machine ID in the Machine ID field.

Type your email address in the Email Address field.

Click Generate.

Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

© xo N

To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

« Access to a computer which is connected to the Internet.

* Your authorization code (a 16-character alphanumeric string).

* The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

Click Generate.
Copy the licenses strings from the web page or the email you receive into a file.
Put the license file onto your target machine.

Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

7. Enter the name and location of the license file.

o gk w
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Updates and Customer Care

Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Customer Care

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

* Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

Select your account and click Entitlements.

Search for the product by using any of the available search parameters.

Click Show all entitlements.

Click Get Software in the Action column for the product you want to download or update.

oW

In the File Type column, you see entries for "Software" for any GA products, and "Patch” for any
patch updates.
6. Click Download on the relevant row.

« The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

* The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

f Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

e The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists.

« The Micro Focus YouTube channel for videos related to your product..

e Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.

Information We Need

If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.
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Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create

them.
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Copyright and Disclaimer

© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS 1S" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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